
USER GUIDE

SMB-2163
Single-Ended Digital I/O Accessory

The SMB-2163 is a breakout box for National Instruments single-ended digital waveform generator/analyzer 
modules. The SMB-2163 provides an easy way to connect to other devices for testing and debugging.

This guide explains how to set up and use the SMB-2163 single-ended digital I/O (DIO) accessory with NI 
single-ended digital waveform generator/analyzer modules.
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Conventions
The following conventions are used in this manual:

<> Angle brackets that contain numbers separated by an ellipsis represent a range of values 
associated with a bit or signal name—for example, DIO <0..3>.

» The » symbol leads you through nested menu items and dialog box options to a final 
action. The sequence File»Page Setup»Options directs you to pull down the File menu, 
select the Page Setup item, and select Options from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to avoid injury, data 
loss, or a system crash. When this symbol is marked on a product, refer to the 
Specifications section for information about precautions to take.

bold Bold text denotes items that you must select or click in the software, such as menu items 
and dialog box options. Bold text also denotes parameter names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction to a key 
concept. This font also denotes text that is a placeholder for a word or value that you must 
supply.

monospace Text in this font denotes text or characters that you should enter from the keyboard, 
sections of code, programming examples, and syntax examples. This font is also used for 
the proper names of disk drives, paths, directories, programs, subprograms, subroutines, 
device names, functions, operations, variables, filenames, and extensions.

What You Need to Get Started
To set up and use the SMB-2163, you need the following items:

* SHC68-C68-D4 (shielded) or C68-C68-D4 (unshielded) cable assembly

* NI digital waveform generator/analyzer, installed in a PXI or CompactPCI chassis

* 50 Ω cables with SMB connectors

* The documentation included with the digital waveform generator/analyzer and driver software

* (Optional) Rack Mount Kit for CA-1000 (part number 777665-01), available from National Instruments
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Related Documentation
The NI digital waveform generator/analyzer ships with several documents designed to familiarize you with 
different aspects of the module. The documentation set includes the following pieces:
• NI Digital Waveform Generator/Analyzer Getting Started Guide—Read this printed document to set up the 

digital waveform generator/analyzer and configure it to complete your first acquisition or generation.
• NI Digital Waveform Generator/Analyzer Help—This online document provides more in-depth information 

about the hardware capabilities of the module, theory of operation, programming flow, and software 
reference.

• NI digital waveform generator/analyzer specifications—This printed document provides specifications for 
your module.

Parts Locator
Refer to Figure 1 to locate connectors on the SMB-2163.

Figure 1.  SMB-2163 Parts Locator Diagram

Installing Cables
Complete the following steps to install the SHC68-C68-D4/C68-C68-D4 cable and any 50 Ω SMB cables.

Notes For applications with low noise or EMC compliance requirements, you must use the 
SC68-SC68-D4 (shielded) cable assembly.

Do not use cables other than the SHC68-C68-D4 (shielded) or C68-C68-D4 (unshielded) 
cable with this accessory.

1 STROBE
2 DDC CLK OUT
3 DIO <0..31>

4 68-Pin Digital Data & Control (DDC) Connector
5 Programmable Function Interface (PFI) <1..3>
6 Shield Ground Lug

SMB-2163
High-Speed DIO Accessory

DIO 20

DIO 24 DIO 25 DIO 26 DIO 27 DIO 28 DIO 29 DIO 30 DIO 31

PFI 1 PFI 2

PFI 3DDC CLK OUT

STROBE DIO 1 DIO 2 DIO 3 DIO 4 DIO 5 DIO 6 DIO 7

DIO 8 DIO 9 DIO 10 DIO 11 DIO 12 DIO 13 DIO 14 DIO 15

DIO 0 DIO 16 DIO 17 DIO 18 DIO 19 DIO 21 DIO 22 DIO 23

3

2

1

4
6

53



4 | ni.com |  

Caution Disconnect power from the device, accessory, and any other connected hardware before 
connecting the cable to prevent damage to the hardware and personal injury. NI is not liable for damage 
resulting from improper connections.

1. Install the driver software and digital waveform generator/analyzer by following the installation procedure 
in the NI Digital Waveform Generator/Analyzer Getting Started Guide.

Note Always install the module in a computer or PXI/CompactPCI chassis before attaching any 
cables or accessories. 

2. Attach either end of the cable assembly to the DDC connector of the digital waveform generator/analyzer and 
secure the cable with the captive screws on the cable connector.

Notes Do not use the SMB-2163 accessory with differential digital signals, such as the digital pattern 
output of the PXI-5421 signal generator.

The SMB-2163 is not compatible with the NI 6533/6534 products.

3. Attach and secure the other end of the cable assembly to the DDC connector of the SMB-2163 and secure 
them together with the captive screws on the cable connector.
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Figure 2 shows how the cable assembly connects the SMB-2163 and the NI digital waveform generator/analyzer.

Figure 2.  Connecting a Single-Ended Digital Waveform Generator/Analyzer 
to the SMB-2163

4. Make signal connections by connecting SMB cables to SMB-2163 signal terminals.

Note To ensure a solid ground connection, tighten the SMB connectors by gently snapping them into 
place.
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Connecting Signals
The SMB-2163 provides connectivity to up to 32 single-ended DIO channels, three programmable function 
interface (PFI) channels, and two clock channels of an NI digital waveform generator/analyzer. You can connect 
to these signals from the labeled SMB connectors on the SMB-2163.

Caution Connections that exceed any of the maximum ratings for the SMB-2163 or the NI digital 
waveform generator/analyzer can damage the device and the computer. Maximum input ratings are 
provided in the specifications document that shipped with the NI digital waveform generator/analyzer. 
NI is not liable for any damages resulting from such signal connections.

Figure 3 shows the pinout of the DDC connector of the accessory. Each DIO, PFI, and clock channel is connected 
to a corresponding pin on the SMB-2163.

Table 1 describes the DDC signals in the pinout.
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Figure 3.  DDC Connector Pinout

Note Refer to the NI Digital Waveform Generator/Analyzer Help at Program Files»National 
Instruments»NI-HSDIO»Documentation»NI Digital Waveform Generator/Analyzer Help for 
information about the number of available DIO channels on your device. DIO <20..31> may not apply 
to your device.
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Note For additional shielding, you can connect the shield ground connector on the SMB-2163 to 
earth/hard ground. This terminal is connected to the shielded enclosure ground. The shield ground lug 
is shown in Figure 1.

Cleaning the Accessory
Disconnect all cables to the SMB-2163 before cleaning. To remove light dust, use a soft, nonmetallic brush. To 
remove other contaminants, use alcohol wipes. The unit must be completely dry and free from contaminants 
before returning to service.

Table 1.  DDC Connector Pinout Descriptions

DDC Pin Signal Description

DIO <0..31> Bidirectional digital data channels 0 though 31.

STROBE External Sample clock source for pattern acquisition.

DDC CLK OUT Exported Sample clock signal.

PFI <1..3> Programmable function interface channels 1 through 3.

GND Ground reference for signals.

RESERVED These channels are reserved for system use. Do not 
connect signals to these channels.
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Specifications

Digital I/O
DIO channels 32, single-ended
Control I/O channels 5, single-ended
Typical propagation delay 
through SMB-2163 ...........................................1.2 ns
Typical channel-to-channel skew ±35 ps
Typical trace 
characteristic impedance...................................50 Ω

Power
Maximum voltage rating 5.5 V

Physical
Dimensions 30.5 cm × 4.5 cm × 26.5 cm

(12.0 in. × 1.77 in. × 10.43 in.)
I/O connectors One 68-pin DDC connector, 37 SMB jack connectors, 

one banana-style connector

CE Compliance
Refer to the regulatory statement for this product for additional compliance information. To obtain this 
information for this product, visit ni.com/hardref.nsf, search by model number or product line, and click 
the appropriate link in the Certification column.

Caution When connected to other test objects, this product may cause radio interference. In a 
residential environment, the user may be required to take adequate measures to reduce the radio 
interference.

Environmental Management
National Instruments is committed to designing and manufacturing products in an environmentally responsible 
manner. NI recognizes that eliminating certain hazardous substances from our products is beneficial not only to 
the environment but also to NI customers.

For additional environmental information, refer to the NI and the Environment Web page at 
ni.com/environment. This page contains the environmental regulations and directives with which NI 
complies, as well as other environmental information not included in this document.
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Waste Electrical and Electronic Equipment (WEEE)
EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling center. 
For more information about WEEE recycling centers and National Instruments WEEE initiatives, visit 
ni.com/environment/weee.htm.

NI Services
Visit ni.com/support to find support resources including documentation, downloads, and troubleshooting and 
application development self-help such as tutorials and examples.

Visit ni.com/services to learn about NI service offerings such as calibration options, repair, and replacement.

Visit ni.com/register to register your NI product. Product registration facilitates technical support and 
ensures that you receive important information updates from NI. 

NI corporate headquarters is located at 11500 North Mopac Expressway, Austin, Texas, 78759-3504, USA. 

RoHS
National Instruments  (RoHS)

National Instruments RoHS ni.com/environment/rohs_china
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)

http://www.ni.com/support
http://www.ni.com/services
http://www.ni.com/register
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Information is subject to change without notice. Refer to the NI Trademarks and Logo Guidelines at ni.com/trademarks for more information on NI trademarks. 
Other product and company names mentioned herein are trademarks or trade names of their respective companies. For patents covering NI products/technology, refer to 
the appropriate location: Help»Patents in your software, the patents.txt file on your media, or the National Instruments Patents Notice at ni.com/patents. You 
can find information about end-user license agreements (EULAs) and third-party legal notices in the readme file for your NI product. Refer to the Export Compliance 
Information at ni.com/legal/export-compliance for the NI global trade compliance policy and how to obtain relevant HTS codes, ECCNs, and other 
import/export data. NI MAKES NO EXPRESS OR IMPLIED WARRANTIES AS TO THE ACCURACY OF THE INFORMATION CONTAINED HEREIN AND 
SHALL NOT BE LIABLE FOR ANY ERRORS. U.S. Government Customers: The data contained in this manual was developed at private expense and is subject to the 
applicable limited rights and restricted data rights as set forth in FAR 52.227-14, DFAR 252.227-7014, and DFAR 252.227-7015.

© 2003–2024 National Instruments Corporation. All rights reserved. 
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